TREK
TELEMETRY PROCESSING
TUTORIAL

November 2012

Approved for Public Release; Distribution is Unlimited.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>PARAGRAPH</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 What You Need To Know Before You Read This Document</td>
<td>1</td>
</tr>
<tr>
<td>2 Technical Support</td>
<td>1</td>
</tr>
<tr>
<td>3 Introduction</td>
<td>1</td>
</tr>
<tr>
<td>4 Telemetry Processing Main Window</td>
<td>2</td>
</tr>
<tr>
<td>5 The Telemetry Processing Tour</td>
<td>4</td>
</tr>
<tr>
<td>5.1 Setting up your TReK System to Receive and Process Data</td>
<td>6</td>
</tr>
<tr>
<td>5.2 Adding a PDSS UDSM Packet</td>
<td>14</td>
</tr>
<tr>
<td>5.3 Setting up your TReK System to Record Data</td>
<td>18</td>
</tr>
<tr>
<td>5.4 Setting up your TReK System to run a local TReK Playback</td>
<td>23</td>
</tr>
<tr>
<td>5.5 Saving a Configuration</td>
<td>29</td>
</tr>
<tr>
<td>5.6 Setting up your TReK system to Receive and Process External Playback Data</td>
<td>32</td>
</tr>
<tr>
<td>5.7 Setting up your TReK System to Forward Data</td>
<td>34</td>
</tr>
<tr>
<td>5.8 Setting up your TReK System to Monitor Data</td>
<td>39</td>
</tr>
<tr>
<td>5.9 Changing a Polynomial Coefficient Calibrator</td>
<td>44</td>
</tr>
<tr>
<td>5.10 Adding a New Sensor</td>
<td>48</td>
</tr>
<tr>
<td>5.11 Changing a Parameter’s Sensor</td>
<td>54</td>
</tr>
<tr>
<td>5.12 Working with Ground Support Equipment (GSE) Packet Parameters</td>
<td>57</td>
</tr>
<tr>
<td>5.13 Adding and Running a Display</td>
<td>62</td>
</tr>
</tbody>
</table>

Appendix A Glossary | 70 |

Appendix B Acronyms | 77 |
## FIGURES

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1 Telemetry Processing Main Window</td>
<td>3</td>
</tr>
<tr>
<td>Figure 2 Add A Packet (General Tab) Dialog</td>
<td>7</td>
</tr>
<tr>
<td>Figure 3 Packet 7 in the Packet List</td>
<td>9</td>
</tr>
<tr>
<td>Figure 4 Packets 7 and 347 in the Packet List</td>
<td>10</td>
</tr>
<tr>
<td>Figure 5 PDSS Payload Packet 7 and Corresponding UDSM Packet</td>
<td>15</td>
</tr>
<tr>
<td>Figure 6 Add A Packet (Options Tab) Dialog</td>
<td>19</td>
</tr>
<tr>
<td>Figure 7 Add A Playback Packet (General Tab) Dialog</td>
<td>23</td>
</tr>
<tr>
<td>Figure 8 Add A Playback Packet (Files Tab) Dialog</td>
<td>25</td>
</tr>
<tr>
<td>Figure 9 Add Dialog</td>
<td>25</td>
</tr>
<tr>
<td>Figure 10 Add A Playback Packet (Files Tab) Dialog</td>
<td>26</td>
</tr>
<tr>
<td>Figure 11 Define Forwarding List</td>
<td>35</td>
</tr>
<tr>
<td>Figure 12 Add Forwarding Address</td>
<td>35</td>
</tr>
<tr>
<td>Figure 13 Monitoring Dialog</td>
<td>40</td>
</tr>
<tr>
<td>Figure 14 Monitoring Messages Dialog</td>
<td>41</td>
</tr>
<tr>
<td>Figure 15 Monitoring Messages</td>
<td>41</td>
</tr>
<tr>
<td>Figure 16 Calibrator MSID008 Properties</td>
<td>45</td>
</tr>
<tr>
<td>Figure 17 Modify Set Dialog for Calibrator MSID008</td>
<td>45</td>
</tr>
<tr>
<td>Figure 18 New Sensor</td>
<td>49</td>
</tr>
<tr>
<td>Figure 19 New Limit Sensor dialog for Sensor1</td>
<td>49</td>
</tr>
<tr>
<td>Figure 20 Add Set dialog for Sensor1</td>
<td>50</td>
</tr>
<tr>
<td>Figure 21 Validation Messages for Sensor1</td>
<td>50</td>
</tr>
<tr>
<td>Figure 22 Modify Description Dialog</td>
<td>51</td>
</tr>
<tr>
<td>Figure 23 Limit Sensor dialog for Sensor1</td>
<td>52</td>
</tr>
<tr>
<td>Figure 24 Modify Parameter dialog for MSID110</td>
<td>55</td>
</tr>
<tr>
<td>Figure 25 GSE Parameter ITWO_32</td>
<td>58</td>
</tr>
<tr>
<td>Figure 26 Default Error Control Object</td>
<td>59</td>
</tr>
<tr>
<td>Figure 27 Displays Dialog</td>
<td>62</td>
</tr>
<tr>
<td>Figure 28 Add Display Dialog</td>
<td>63</td>
</tr>
<tr>
<td>Figure 29 Add (Parameter) Dialog</td>
<td>64</td>
</tr>
<tr>
<td>Figure 30 Add Display Dialog Populated with Parameters</td>
<td>65</td>
</tr>
<tr>
<td>Figure 31 Display1</td>
<td>67</td>
</tr>
<tr>
<td>Figure 32 Display1 with Data</td>
<td>68</td>
</tr>
<tr>
<td>Figure 33 Display1 After Moving the Value Column</td>
<td>68</td>
</tr>
</tbody>
</table>
1 What You Need To Know Before You Read This Document

Before reading this document you should be familiar with the material in the TReK Getting Started User Guide (TREK-USER-001) and the TReK Telemetry Tutorial (TREK-USER-002). If you have not read these documents, you may have difficulty with some of the terminology and concepts presented in this document.

We assume you are an experienced Windows user. Information about how to use a mouse or how to use Windows is not addressed in this user guide. Please see your Windows documentation for help with Windows.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK software applications, please try the following suggestions:

Read the appropriate material in the manual and/or on-line help.

Ensure that you are correctly following all instructions.


If you are still unable to resolve your difficulty, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone: 256-544-3521 (8:00 a.m. - 4:30 p.m. Central Time)
Fax: 256-544-9353

TReK Help Desk hours are 8:00 a.m. – 4:30 p.m. Central Time Monday through Friday. If you call the TReK Help Desk and you get a recording please leave a message and someone will return your call. E-mail is the preferred contact method for help. The e-mail message is automatically forwarded to the TReK developers and helps cut the response time.

3 Introduction

The TReK Telemetry Processing application provides the capability to monitor and control all telemetry processing activity on your TReK system. As discussed in the TReK Telemetry Tutorial, a TReK system can receive telemetry data from multiple sources. Although multiple types of telemetry packets from multiple sources may be arriving at your TReK system, it’s up to you to decide whether to accept those telemetry packets or let them drop. The Telemetry Processing application is used to identify which
telemetry packets should be accepted by your TReK system and what to do with the packets when they arrive. You can make these decisions in real time and you can change your configuration at any time. You may be wondering why you would ever let packets drop. This type of scenario may occur when you are not interested in the data in a particular stream at a particular time, or when you are in a situation when it is important to reserve precious resources (such as CPU power and memory.)

Once you have decided to accept a particular telemetry packet (see the TReK Telemetry Tutorial for information about uniquely identifying a telemetry packet) there are several things you can do with the packet. You can choose to process the packet (there are several different types of processing options available) or pass the packet through. If you process the packet, you can retrieve the individual parameters in the packet using the TReK API. If you use the Pass-Thru capability, you will be able to retrieve the raw contents of the packet using the API, but not the individual parameters that make up the packet. Regardless of whether you process the packet or use the Pass-Thru capability, you also have the option of recording and/or forwarding the packet. If you record the packet, you can also use the Telemetry Processing application to play the packet back (i.e., send it back through your TReK system). This is called a local TReK playback. When you play the packet back, you will again have the option of processing, passing-thru, recording, or forwarding the packet. If you specify that a packet should be forwarded, the incoming packets will be routed to the machines or devices you specify as they arrive. You can forward multiple packets to multiple machines and devices all at the same time.

Other features in the Telemetry Processing application include the ability to modify processing attributes such as calibration, sensing, switching, and monitoring. You can also automatically generate a display to view any data that you are processing (real-time data or playback data). There are also capabilities to set telemetry processing options and view telemetry processing status information.

4 Telemetry Processing Main Window
The Telemetry Processing main window consists of two main areas as shown in Figure 1. The top part of the main window contains the list of packets that your TReK system should accept and identifies what will be done with the packets when they arrive. When you start the Telemetry Processing application the list will be empty. This is because you have not yet added any packets to the list. The bottom part of the window is a message area that is used to display important status and error information messages about the telemetry processing activities in progress.
There are eight pieces of information that are displayed for each packet in the packet list. They are Packet ID, Packet Type, Data Mode, Port Number, Processing, Recording, Forwarding, and Playback. The Packet ID, Packet Type, and Data Mode are used together to uniquely identify the packet. The Processing, Recording, Forwarding and Playback columns identify the status of each of those activities. The Playback information is only applicable to local TReK playback packets.

In Figure 1 the first packet in the list is packet 2 which is a PDSS Payload RealTime packet. This packet has been activated meaning that the TReK system is actively accepting this packet. This packet has been set up so it will be processed and recorded. This is indicated by the status information in the Processing and Recording columns. The second packet in the list is a playback packet. This is indicated by the Active status shown in the Playback column. This packet has been set up to be processed but not recorded. This is why the Recording column indicates that recording is Off. It is possible to turn recording on even if this option was not selected when the packet was originally added. The third packet in the list is packet 3 which is a PDSS Payload RealTime packet. This packet has not been activated yet. This is indicated by the Inactive status shown in the Processing, Recording, and Forwarding columns. The fourth packet in the list is packet 7 which is a PDSS Payload RealTime packet. This packet has been set up so it will be processed and forwarded but not recorded. All the packets in the packet list are controlled using the Packet menu. There are also additional options on the File menu that provide a way to save a packet list configuration.

If you are running the Telemetry Processing application or viewing this document from within Microsoft Word then you have probably noticed that each packet row has a color associated with it. The color provides information about the packet. For example, when using the default colors, if the packet row is black, this indicates that the packet has not been activated. If the packet row is purple, this indicates that the packet is initializing. If
the packet row is blue, this indicates that the packet is activated but that no data has arrived. If the packet row is green, this indicates that data packets are arriving. The colors are helpful in providing immediate information about the general configuration and processing status of each packet in the list.

5 The Telemetry Processing Tour

Sometimes it’s easier to learn how to use an application by example. This section introduces you to the main functions that you can perform using the Telemetry Processing application by showing you an example for each one. Each section provides an introduction to a particular capability and provides a step-by-step example that demonstrates how to use the capability. Here are the topics that will be covered:

- Setting up your TReK System to Receive and Process Data
- Adding a PDSS UDSM Packet
- Setting up your TReK System to Record Data
- Setting up your TReK System to run a local TReK Playback
- Saving a Configuration
- Setting up your TReK system to Receive and Process External Playback Data
- Setting up your TReK System to Forward Data
- Setting up your TReK System to Monitor Data
- Changing a Polynomial Coefficient Calibrator
- Adding a New Sensor
- Changing a Parameter’s Sensor
- Working with Ground Support Equipment (GSE) Packet Parameters
- Adding and Running a Display

This section was written assuming that you have read the Introduction section (section 3) and the Main Window section (section 4). If you have not read these sections, please go back and read them. They contain important information that is not repeated in this section.

Since this part of the document is more like a hands-on tutorial it is highly recommended that you print out section 5 so you have a paper copy to read while you work through each section.

Please go through the tour in order. Some sections depend on data from previous sections.
Setting up your TReK System to Receive and Process Data
5.1 Setting up your TReK System to Receive and Process Data

The Telemetry Processing application’s main purpose in life is to receive and process data. Therefore, we’ll start with this capability. In the TReK Telemetry Tutorial (TREK-USER-002) you learned that your TReK system can receive data from different sources. This example will show you how to set up your TReK system to receive data from two different sources. Since you may not have any external data sources available right now, we’ll use the TReK Telemetry Trainer application to simulate the two different data sources.

Step-By-Step

1. If you haven’t started the Telemetry Processing Application, use the Windows Start menu to start the application. You may notice that it takes a few seconds for the application’s main window to appear. This is because the application has quite a bit of background setup work to perform in order to prepare for the telemetry processing work that lies ahead.

2. The first thing we’re going to do is to add a packet to the main window packet list. Remember that by adding a packet to the main window packet list you are telling your TReK system that you want it to look for that particular packet and if it arrives you want it to pick it up and do something with it (like process it or record it). Go to the Packet menu and select Add A Packet. The Add A Packet dialog shown in Figure 2 will appear. We will use this dialog to provide information about the packet we want to receive.
3. In the Add A Packet dialog enter the following information:

- **Database:** TelemetryDatabase.mdb  
  Hint: Don’t forget to enter the full directory path. The Browse button provides a way to select the database and will fill in the full directory path for you.

- **Packet ID (APID):** 7
- **Packet Type:** PDSS Payload
- **Data Mode:** RealTime
- **Type of Processing:** Process Entire Packet
- **Local IP Address:** Enter your IP address in the field.  
  Hint: This field should have defaulted to your local Unicast IP Address.

- **Local Port Number:** 6100
- **Protocol:** UDP
- **Expected Packet Rate:** 1 (Pkts/Sec)
What does all this mean?

The **Database** tells your TReK system where to find all the information it needs in order to process (decommutate) the packet when it arrives. The database also contains information about processing elements such as sensors and calibrators. This information is used when your data is limit sensed or calibrated.

The **Packet ID (APID)** is the Application Process Identifier (APID) of the packet you want to receive. The Packet ID along with the Packet Type and Data Mode uniquely identifies the packet.

The **Packet Type** tells your TReK system what type of packet to look for. Remember from the TReK Telemetry Tutorial that your TReK system can receive different types of packets such as PDSS Payload packets, Suitcase Simulator packets, etc. The Packet Type along with the Packet ID and the Data Mode uniquely identifies the packet.

The **Data Mode** tells your TReK system what data mode is associated with the packet. The data mode along with the Packet ID and the Packet Type uniquely identifies the packet. In some situations you may receive the same packet in multiple data modes. For example, suppose your experiment is generating data on-board the Space Station and that data is being transmitted to the ground. The POIC PDSS system will distribute the data as RealTime data. Suppose that 2 hours earlier there was a Loss of Signal (LOS) and during this LOS the data was recorded on-board. Later, when the recorded data is downlinked to the ground it needs to be distributed. The POIC PDSS system will distribute this data as dump data using one of the dump data modes such as Dump1. If you want to receive both your realtime data and your dump data, then you would configure your TReK system to look for both. That is why Data Mode is part of what makes a packet unique. It allows you to differentiate between different data streams.

**Type of Processing** tells your TReK System what to do with the data when it arrives. You have several choices. Process Entire Packet tells your TReK system to decommutate the data. This means that the packet will be broken up into its individual pieces based on the packet definition stored in the database you identified. By processing the data you will be able to retrieve individual pieces of the packet and take advantage of TReK capabilities such as calibration and sensing. The **TReK User Application Programming Interface Reference Manual** (MSFC-DOC-2800) explains all the different ways that you can retrieve individual pieces of data.

**Local IP Address** and **Local Port Number** tell your TReK System where the packet is going to arrive when it gets to your PC. These two pieces of information are like a home address.

**Protocol** tells your TReK System how the data is being transmitted.

**Expected Packet Rate** tells your TReK system how often to expect new data to arrive (for this particular stream -- Packet ID (APID)/Data Mode/Packet Type combination).
Note: For information about the remaining dialog items, please reference the Telemetry Processing User Guide. The Options tab provides access to optional packet services such as packet recording, packet forwarding etc. These will be discussed later.

4. When you are done entering this information push the OK button. You should now see packet 7 in the main window packet list as shown in Figure 3.

![Figure 3 Packet 7 in the Packet List](image)

5. Add a second packet with the following properties:

Database: TelemetryDatabase.mdb

Packet ID: 347

Packet Type: Suitcase Simulator

Data Mode: None

Note: Suitcase Simulator packets are CCSDS packets. They do not have an EHS header. Therefore, there is no data mode associated with Suitcase Simulator packets.

Type of Processing: Process Entire Packet

Local IP Address: Enter your IP address in the field.

Hint: This field should have defaulted to your local Unicast IP Address.

Local Port Number: 6101
Note: Make sure you enter 6101. You need to use a different port number than the one you used for the PDSS packets. Recall from the TReK Telemetry Tutorial (TREK-USER-002) that Suitcase Simulator packets do not have an EHS header. Therefore, they need to be sent to a different port than EHS Protocol packets (like PDSS Payload packets) that do have an EHS Header.

Protocol: UDP
Expected Packet Rate: 1 (pkts/sec)

6. When you are done entering this information push the OK button. You should now see a PDSS Payload Packet 7 and Suitcase Simulator Packet 347 in the main window packet list as shown in Figure 4.

![Figure 4 Packets 7 and 347 in the Packet List](image)

7. So far we still haven’t told our TReK system to do anything. That’s what comes next. Select the first packet in the list (PDSS Payload Packet 7). Go to the Packet menu and select Activate Packet. You will see a message in the message area of the main window indicating that the packet is initializing. The color of the packet will go from black to purple (if you have not changed the default colors). When you activate a packet you are telling your TReK system to get everything set up so it is ready to take care of the packet when it arrives. During the packet activation process your TReK system is reading the database to retrieve all the information it needs in order to process the packet (if processing was requested). It is also setting up for any of the other functions you may have requested such as packet recording or packet
forwarding (which will be discussed later). Once the packet is activated you will see several messages in the message area associated with packet activation. If you have the color feature turned on then your packet will turn blue once it has been activated (if you have not changed the default colors).

8. Activate the Suitcase Simulator Packet 347. (Hint: Don’t forget to select the Suitcase Simulator packet before you select Activate Packet.).

9. Now that our TReK system is ready to receive data we need to send it some data. Since we don’t have any external data sources (such as the POIC or a Suitcase Simulator system), we’ll use the TReK Telemetry Trainer application to generate our packets. If you performed the Telemetry Step-By-Step procedure in the TReK Getting Started Guide (TREK-USER-001) this should be familiar. If you haven’t read that part of the Getting Started Guide you might want to refer to the Getting Started Guide Step-By-Step section or to the TReK Telemetry Trainer User Guide (TREK-USER-004) as you perform the following steps. To start sending data perform the following steps:

   a. Use the Windows Start menu to start the Telemetry Trainer application.

   b. Use the Add A Packet dialog to add Packet ID 7 to the Telemetry Trainer packet list. All the fields in the Add A Packet dialog will be filled with defaults except the Packet ID and the Database field. Enter 7 in the Packet ID field and the full path for the TelemetryDatabase.mdb database in the Database field.

   c. Use the Add A Packet dialog to add Packet ID 347 to the Telemetry Trainer packet list. In the Packet ID field enter 347. Use the TelemetryDatabase.mdb database again. In the Packet Type combo box select Suitcase Simulator. When you select Suitcase Simulator, the Data Mode combo box will automatically be set to None. Suitcase Simulator packets do not have an EHS header so they do not have a data mode. In the Port Number field enter 6101. Remember that you told the Telemetry Processing application to look for packet 347 on port 6101. If you don’t send packet 347 to port 6101 then the Telemetry Processing application won’t receive it because it is expecting it to arrive on port 6101 and that’s the only place it will be looking for it.

   Note: Remember you want to send the same packets that you have set your TReK system up to receive. There should be a one-to-one correspondence between the information you entered in the Telemetry Processing application and the information you entered in the Telemetry Trainer application (Packet IDs, Packet Type, Data Mode, IP Address, and Port Numbers).

   d. Once both packet 7 and packet 347 are in the list, use the Send button on the Packet menu to start sending both packets.
So … What happened?

10. Here’s what should have happened: The PDSS Payload Packet 7 and Packet 347 in the Telemetry Processing application should have turned green as soon as you started sending data (if you haven’t changed the default colors). The green color indicates that you are receiving data. As soon as you stopped receiving data, packet 7 and packet 347 should have turned gold. Gold indicates that you are not receiving any new data. (Note: If you didn’t see what was described above, then the most likely source of the problem is a mismatch in what you are sending compared to what you are set up to receive. Try starting over again and pay close attention to the data values that should be entered in both the Telemetry Processing application and the Telemetry Trainer application.).

And that’s how you set up your TReK System to receive and process data.

Please exit the Telemetry Processing application and the Telemetry Trainer application before moving on to the next section. (Hint: When you are asked if you’d like to save your changes – just say no! We’re going to talk about saving configurations in section 5.5).
Adding a PDSS UDSM Packet
5.2 Adding a PDSS UDSM Packet

For each PDSS Payload packet there is a corresponding PDSS User Data Summary Message (UDSM) packet. In most cases it’s a good idea to add a PDSS UDSM packet for each PDSS Payload packet that you add. This section shows you an easy way to add a PDSS UDSM packet that corresponds to a particular PDSS Payload packet.

Step-By-Step

1. Start the Telemetry Processing application.

2. Go to the Packet menu and select Add A Packet to add packet 7 with the following properties:

   - Database: TelemetryDatabase.mdb
     Hint: Don’t forget to enter the full directory path. The Browse button provides a way to select the database and will fill in the full directory path for you.
   - Packet ID (APID): 7
   - Packet Type: PDSS Payload
   - Data Mode: RealTime
   - Type of Processing: Process Entire Packet
   - Local IP Address: Enter your IP address in the field.
     Hint: This field should have defaulted to your local Unicast IP Address.
   - Local Port Number: 6100
   - Protocol: UDP
   - Expected Packet Rate: 1 (Pkts/Sec)

3. Push the OK button in the Add A Packet dialog.

4. Select packet 7 in the list. Once it’s selected go to the Packet menu and select Add Corresponding UDSM Packet. When the Add Corresponding UDSM Packet for Packet <Packet ID> dialog comes up notice that it is already populated with all the correct attributes for the PDSS UDSM packet. Also note that the items that must match the items in the corresponding PDSS Payload packet are insensitive since they should not be changed. All you have to do is push the OK button. Your main window should now look like the one in Figure 5.
5. Now we need to activate both packets. For each packet in the list select the packet and then go to the **Packet** menu and select **Activate Packet**.

6. Now that our TReK system is ready to receive data we need to send it some data. Since we don’t have any external data sources (such as the POIC or a Suitcase Simulator system), we’ll use the TReK Telemetry Trainer application to generate our packets. This is the same basic procedure we performed in the last section. To start sending data perform the following steps:

   a. Use the Windows Start menu to start the Telemetry Trainer application.
   b. Use the Add A Packet dialog to add Packet ID 7 to the Telemetry Trainer packet list. All the fields in the Add A Packet dialog box will be filled with defaults except the Packet ID and the Database field. Enter 7 in the Packet ID field and the full path for the TelemetryDatabase.mdb database in the Database field.

   **Note:** Remember you want to send the same packet that you have set your TReK system up to receive. There should be a one-to-one correspondence between the information you entered in the Telemetry Processing application and the information you entered in the Telemetry Trainer application (Packet IDs, Packet Type, Data Mode, IP Address, and Port Numbers).

   **Note 2:** You do not have to add a PDSS UDSM packet. The Telemetry Trainer application will automatically generate this packet for you. A
PDSS UDSM packet will be generated after all the PDSS Payload packets have been sent. Please note that if you pause or stop the packet, a UDSM packet is not generated. The UDSM packets are only generated by the Telemetry Trainer application when all of the PDSS Payload packets have been sent (based on the Run Time field).

c. Once packet 7 is in the list, use the Send button on the Packet menu to start sending the packet.

So … What happened?

7. Here’s what should have happened: The PDSS Payload Packet 7 in the Telemetry Processing application should have turned green as soon as you started sending data (if you haven’t changed the default colors). The green color indicates that you are receiving data. As soon as you stopped receiving data, packet 7 should have turned gold. Gold indicates that you are not receiving any new data and the data that you currently have is stale. (Note: If you didn’t see what was described above, then the most likely source of the problem is a mismatch in what you are sending compared to what you are set up to receive. Try starting over again and pay close attention to the data values that should be entered in both the Telemetry Processing application and the Telemetry Trainer application.). What happened with the PDSS UDSM packet? You may have noticed that as soon as the PDSS Payload packet turned gold the PDSS UDSM packet turned green for a moment and then turned gold. This simulates what will happen when an LOS occurs and you stop receiving data – PDSS will output a UDSM packet that contains information about the last set of PDSS Payload packets that were distributed before the LOS occurred. PDSS only outputs one PDSS UDSM packet when an event occurs. For more information about PDSS UDSM packets (what they are, when they are sent by PDSS) please see the POIC to Generic User Interface Definition Document (SSP-50305).

And that’s how you set up your TReK System to receive and process a PDSS UDSM packet.

Please exit the Telemetry Processing application and the Telemetry Trainer application before moving on to the next section. (Hint: When you are asked if you’d like to save your changes – just say no! We’re going to talk about saving configurations in section 5.5).
Setting up your TReK System to Record Data
5.3 Setting up your TReK System to Record Data

In some situations you may want to record the data that you are receiving. This example shows you how to set up packet recording for a particular packet. The next example will explain how to play the data back.

Step-By-Step

1. Start the Telemetry Processing application.

2. Go to the Packet menu and select Add A Packet. On the General page of the Add A Packet dialog enter the following:

   - **Database:** TelemetryDatabase.mdb
     - Hint: Don’t forget to enter the full directory path. The Browse button provides a way to select the database and will fill in the full directory path for you.
   - **Packet ID:** 7
   - **Packet Type:** PDSS Payload
   - **Data Mode:** RealTime
   - **Type of Processing:** Process Entire Packet
   - **Local IP Address:** Enter your IP address in the field.
     - Hint: This field should have defaulted to your local Unicast IP Address.
   - **Local Port Number:** 6100
   - **Protocol:** UDP
   - **Expected Packet Rate:** 1 (Pkts/Sec)

3. Go to the Options tab in the Add A Packet dialog. On the Options tab enter the following:

   In the Packet Recording Section
   - **Recording:** On
   - **Base Filename:** packet7
   - **Directory:** C:\
     - Note: If you don’t have a C drive you can use a different drive.
   - **Packet Forwarding:** Off
   - **Packet Viewing:** Off
   - **Packet Statistics Recording:** Off

   The Options tab should look like Figure 6.
4. Go to the Packet menu and select Activate Packet.

5. Once the packet is activated go to the Telemetry Trainer application and add packet 7 with the following properties and start sending the packet.

   Database: TelemetryDatabase.mdb
   Hint: Don’t forget to enter the full directory path. The Browse button provides a way to select the database and will fill in the full directory path for you.

   Packet ID (APID): 7
   Packet Type: PDSS Payload
   Data Mode: RealTime
   Source Port Number: 5700
   Destination IP Address: Enter your IP address in the field.
   Hint: This field should have defaulted to your local Unicast IP Address.
Destination Port Number: 6100
Protocol: UDP
Transmission Rate: 1 (# Pkts/Sec)
Run Time (seconds): 25

6. Once packet 7 in the Telemetry Processing application turns gold then it has stopped receiving packets. When this happens go to the Telemetry Processing Packet menu and select Stop Recording. When you select Stop Recording the recording process stops and the last recording file that was open is closed.

7. Now let's go to the directory where we stored our recording file(s) (C:) and see what we have. You should find two files that look something like this:

```
TRT 2004-08-05 18~19~55~109 2004-08-05 18~20~04~109 packet7
SCT 2004-08-05 17~49~55~105 2004-08-05 17~50~04~105 packet7
```

When data is recorded on your TReK system a complete copy of the raw packets along with the TReK receipt time associated with their arrival are stored in one or more files in a local directory. In addition, if the packet contains a Consultative Committee for Space Data Systems (CCSDS) secondary header, the spacecraft time information contained inside this secondary header is processed and also stored in the file (PDSS payload packets are one example of packets containing this secondary header).

The name of each recording file is specified in part by you and in part by your TReK system. This is an example of a TReK Receipt Time (TRT) data recording filename:

```
TRT 2004-08-05 18~19~55~109 2004-08-05 18~20~04~109 packet7
```

If the packet contains a CCSDS secondary header an additional filename containing the Spacecraft Time (SCT) reference will be generated. This is an example of a spacecraft time data recording filename:

```
SCT 2004-08-05 17~49~55~105 2004-08-05 17~50~04~105 packet7
```

The first part of the TRT filename (2004-08-05 17~49~55~105) indicates the time of arrival of the first packet in the file in Greenwich Mean Time (GMT). The second part of the filename (2004-08-05 17~50~04~105) indicates the time of arrival of the last packet in the file in GMT. The SCT filename is interpreted in a similar manner except the start and stop times reference the spacecraft time contained in the CCSDS secondary header of the first and last packet in the file. The start time and stop times identify the time span associated with the data stored in the file. The last part of the filename (packet7) is called the base filename. When you set up data recording you will be asked to provide a base filename for your data recording files as well as the path for a local directory where the files should be stored.
If you have selected to record a packet, the following sequence of recording events will occur when the packets arrive:

- Packet arrives
- Packet is identified
- The packet will be stored in the file.
- If the data recording file is full or the Maximum Time File Is Open property has expired, the file will be closed and renamed with the TRT filename. If the packet contains a CCSDS secondary header, the SCT filename will also be created in the form of a shortcut to the recorded data file. A new data recording file will then be opened (marked with the GMT TReK receipt start time) and the next packet will be stored in the new file.

Your TReK system uses the Maximum File Size property and or the Maximum Time File Is Open property to determine when a file should be closed. Please keep in mind that if you are using the Maximum Time File Is Open property to close your recording files, the open file timer associated with your record file will start when the first packet is recorded. This means that if no packets are recorded, the file will remain open until you close it manually. The Maximum File Size property and the Maximum Time File Is Open properties can be set using the Advanced Recording dialog. Please reference the Telemetry Processing User Guide (TREK-USER-003) for details.

And that’s it – now you’ve recorded some data. If you’d like to see how to play the data back, try out the next example in section 5.4.

Please exit the Telemetry Processing application and the Telemetry Trainer application. (When you are asked if you’d like to save your changes – just say no! We’re going to talk about saving configurations in section 5.5).
Setting up your TReK System to run a local TReK Playback
5.4 Setting up your TReK System to run a local TReK Playback

Once you’ve recorded some data you’ll probably want to play it back. This example will explain how to run a local TReK playback. A local TReK playback is different than an external playback. A local TReK playback refers to the process of reading packets from one or more files that were created using the packet recording capability on a TReK system. An external playback refers to the scenario where you receive data from an external source (such as the POIC) that is marked with a playback data mode such as Playback1 or Playback2.

In this example, we will use the data we recorded in the example above. If you have not performed the Step-By-Step procedure in section 5.3 please go back and do this before performing the steps below.

Step-By-Step

1. Start the Telemetry Processing application.

2. To run a local TReK playback you first need to add a playback packet. Go to the Packet menu and select Add A Playback Packet. The Add A Playback Packet dialog in Figure 7 will be displayed.

![Add A Playback Packet (General Tab) Dialog](image)

Figure 7 Add A Playback Packet (General Tab) Dialog
3. Make the following updates to the data in the General Tab of the Add A Playback Packet dialog.

Database:  <Full Path>\TelemetryDatabase.mdb

A Few Notes:

a. There are thirteen different data modes that you can assign to a playback: None, Realtime, and Playback1 through Playback11. The None data mode must be used with Suitcase Simulator data and cannot be used with any other type of data.

b. There are two playback modes: Continuous Mode and Pulse Mode. In Continuous Mode the data will be played back until there is no more data or you push the Stop Playback button. You can specify the number of times to play the recorded data segment or to loop indefinitely. In Pulse Mode the data will only be played back when you push the Pulse Playback button.

c. The Specify Rate and Use Native Rate radio buttons are associated with the Continuous playback mode. The Specify Rate field tells your TReK system what data rate to use (how fast or how slow) when playing back the packets. If you prefer to play the packets back at the same rate that the packets were originally received use Native Rate.

d. The Pulse Rate field is associated with the Pulse playback mode. The number of packets played back when you push the Pulse Playback button is determined by the value you enter in the Pulse Rate field. This field is only available when you select Pulse.

e. The Packet Ordering menu provides a way for you to identify how the packets should be ordered when they are played back. There are three choices: Playback Packets In The Order Received, Reorder the Packets Based On Time, and Reorder the Packets Based On Time and Remove Duplicates. Duplicates can occur if you have identified multiple sets of recorded data that overlap in time. This can occur if you are working with recording files that contain both realtime data and dump data. There may be some timeframe in which the same packets were recorded in both sets of recording files. In this situation you may want to identify both sets of recording files in order to merge them together into one contiguous time frame, but you want to remove any duplicates that were the result of the time overlap.
4. Go to the Files tab. You will see the dialog shown in Figure 8. Since we are going to be playing data back, we need to provide some information about the recording files where the data is stored.

![Add A Playback Packet (Files Tab) Dialog](image1)

Figure 8 Add A Playback Packet (Files Tab) Dialog

5. On the Files Tab push the Add button. You will see the dialog shown in Figure 9.

![Add Dialog](image2)

Figure 9 Add Dialog
6. In the Add dialog enter the following information and push the OK button.

   | Start Time Year:       | 2003      |
   | Original Base Filename:| packet7   |
   | Original Recorded Data Directory: | C:\          |

Note: This should be the directory you used when you recorded the data.

The Files Tab should now look like Figure 10.

![Add A Playback Packet (Files Tab) Dialog](image)

**Figure 10 Add A Playback Packet (Files Tab) Dialog**

A Few Notes:

a. The Start Time information tells your TReK system where to start the playback. You can choose to start the playback at any location within the time span associated with the recorded data. The start time does not have to be an exact match with the start time on any of the files. It can be any time before or after the start time on the first file. This is why we only changed the Start Time Year field.
b. The Stop Time information tells your TReK system where to stop the playback. You can choose to stop the playback at any location within the time span associated with the recorded data. The stop time does not have to be an exact match with the stop time on any of the files. It can be any time after the start time on the first file.

c. You can also use the Browse button to select the recorded data files you want to use.

Note that like the Add A Packet dialog, the Add A Playback Packet dialog also has an Options Tab. The Add A Playback Packet's Options Tab provides a way to configure optional playback packet services such as recording, forwarding, and viewing.

7. Push the OK button to add the playback packet to the packet list.

8. Now that the packet is in the list, all we need to do is to start the playback. You start the playback by activating the packet and then pushing the Start Playback button. Go to the Packet menu and select Activate Packet. You will see several messages in the message area as the playback packet is activated. Once the playback packet is activated it will turn blue (if you haven’t changed the default colors). Once the playback packet is activated, go to the Packet menu and select Start Playback. Once the playback starts the packet color will turn green. This indicates that playback packets are being received. When the playback stops you will see a message in the message area and the packet color will turn gold.

9. By using other menu items on the Packet menu you can control the playback. For instance, you can pause the playback using Pause Playback. Then you can resume the playback using Resume Playback. You can stop the playback using Stop Playback. If you stop a playback or it completes and you want to run it again you can select Start Playback again. If you had configured the playback to run in Pulse Mode, the Pulse Playback menu item would be available. You would use the Pulse Playback button to play the packets back at the pulse rate you specified when you configured the playback.

10. Please exit the Telemetry Processing application. (When you are asked if you’d like to save your changes – just say no! We’re going to talk about saving configurations in section 5.5).

That’s it – now you know how to run a local TReK playback.
Saving a Configuration
5.5 Saving a Configuration

If you just finished working through the last few examples you may be thinking: “It sure would be nice if I could save all my configuration information so I didn’t have to enter it each time I start the Telemetry Processing application.” Well, as it turns out you can. That’s what this example is all about – Saving a Configuration.

Step-By-Step

1. Start the Telemetry Processing application and add packet 7 to the packet list with the following properties:

   - Database: <Full Path>\TelemetryDatabase.mdb
   - Packet ID: 7
   - Packet Type: PDSS Payload
   - Data Mode: RealTime
   - Processing Type: Process Entire Packet
   - Local IP Address: <Your IP Address>
   - Local Port Number: 6100
   - Protocol: UDP
   - Expected Packet Rate: 1 (Pkts/Sec)
   - Packet Recording: Off
   - Packet Forwarding: Off
   - Packet Viewing: Off
   - Packet Statistics Recording: Off

2. Go to the Packet menu and select Activate Packet. If you look at the File menu while the packet is initializing, you will see that the New, Open, Save, Save As, and Exit menu items are insensitive. You cannot perform any of these functions while there are packets in the packet list that are activating. As soon as the packet(s) have completed initialization, the menu items will be available again.

3. Go to the File menu and select Save. You will be prompted for a filename and a directory location. Enter packet7 for the filename and push Save.

   Note: When you save a configuration, the Telemetry Processing application will default to the <base_path>\configuration_files\telemetry_processing directory. The <base_path> for the Windows 2000 operating system is:

   
   <base_path> = C:\Documents and Settings\<username>\Application Data

You can save your configuration files anywhere you like, but this default directory provides an easy way for you to keep up with your files.
4. Exit the Telemetry Processing application.

5. Start the Telemetry Processing application.

6. Go to the **File** menu and select **Open**. The Open dialog will default to the `<base_path>\configuration_files\telemetry_processing` directory. Select the `packet7.tpc` file and push **Open**.

7. Your configuration will be opened. You should see the full path name for you configuration file in the application title bar and you should see a message in the message area stating that your configuration was opened.

8. Go to the **Packet** menu and select **Activate Packet**. Notice how fast the packet activated? This is because when you saved the configuration all the information about the packet was saved in a file. This includes all the database information that is normally retrieved when the packet is activated and any processing information associated with the packet.

   **Important Note:** When you activate a packet that was previously activated and then saved in a configuration file, all the information needed for the packet is read from the file. In this scenario no information is retrieved from the database. Therefore, any changes made in the database will not be used since they will not be retrieved. You need to remember this. If you want to ensure that the database is read, then you should use the Add A Packet dialog box to add the packet and then activate it. This will ensure that you pick up any changes made in the database.

   There is one caveat to this: The Set Telemetry Processing Options dialog (available from the Options menu) has a setting called **Save Database Information in Configuration File for Activated Packets**. This property tells your TReK system whether to save database information in configuration files for activated packets. When you activate a packet, TReK retrieves information about the packet from the database. The default behavior is to save this database information when you save a configuration. However, if you uncheck this box, your TReK system will not save any database information for any packets regardless of whether the packet(s) are activated. This means that the next time you open the configuration file and activate the packets, TReK will access the database for information (because there will be no database information stored in the configuration file).

9. Please exit the Telemetry Processing application.
Setting up your TReK system to Receive and Process External Playback Data
5.6 Setting up your TReK system to Receive and Process External Playback Data

Setting up your TReK system to receive external playback data is nearly identical to setting up your TReK system to receive RealTime data. It is so simple we don’t even need a Step-By-Step section. To receive external playback data use the Add A Packet dialog to add the packet of interest to the packet list. When you’re in the Add A Packet dialog you will have to enter a data mode. You simply enter the playback data mode that matches the data mode being used by the external data source that is generating the external playback. For example, if the POIC generates an external playback and they tag the data with the Playback5 data mode then all you need to do is select Playback5 in the Data Mode combo box in the Add A Packet dialog box. It’s as simple as that. You may be wondering how you find out what external playbacks are being generated and what data mode is being used. Please refer to SSP-50305 POIC to Generic User Interface Definition Document (PGUIDD) for more information about external playbacks.

Note: The POIC will not be generating external playbacks for early flights so this information may not appear in the PGUIDD until a later date.
Setting up your TReK System to Forward Data
5.7 Setting up your TReK System to Forward Data

Suppose that you’re the only person on your team that will receive data from the POIC. But suppose you’d like for someone else in your group to get the data too. Instead of doing all the paperwork that would be necessary to add another IP address to the POIC’s packet distribution list for your APID, you can use your TReK system to forward the data to your buddy. To really see this work you need at least two PCs loaded with the TReK software. However, if you don’t have access to two PCs it would still be worthwhile to follow along to see how to set things up. Keep reading to see how it works.

Step-By-Step

1. Start the Telemetry Processing application.

2. Add packet 2 to the packet list and set the following properties in the Add A Packet dialog box (you will need to enter data using both the General tab and the Options tab):

   - Database: \TelemetryDatabase.mdb
   - Packet ID: 2
   - Packet Type: PDSS Payload
   - Data Mode: RealTime
   - Processing Type: Process Entire Packet
   - Local IP Address: <Your IP Address>
   - Local Port Number: 6100
   - Protocol: UDP
   - Expected Packet Rate: 1 (Pkts/Sec)
   - Packet Recording: Off
   - Packet Forwarding: On
   - Packet Viewing: Off
   - Packet Statistics Recording: Off

3. Since you’ve turned Forwarding on you need to define the destinations where you want the packets forwarded. Push the Define Forwarding List button on the Options Tab and the Forwarding List dialog shown in Figure 11 will be displayed. This dialog has three tabs: Network Destinations, Device Destinations, and All Destinations. You can forward data to network destinations and device destinations. You add network destinations using the Network Destinations tab, and you add device destinations using the Device Destinations tab. The All Destinations tab shows the entire forwarding list. In this exercise we’re just going to forward the packets to a network destination.
4. Be sure you’re on the **Network Destinations** tab and push the **Add…** button to add a forwarding address to the list. The Add Forwarding Address dialog shown in Figure 12 will be displayed. If you have another machine to try this with add the IP Address
for that machine and 6100 for the port number. Push the OK button to add the address to the list.

Note: Notice that you can specify whether to forward the data using UDP or TCP. Also, the Forward menu provides a way to identify which portion of the packet to forward. You can choose to forward the entire packet (with all headers), the EHS Packet, the CCSDS portion of the packet (the EHS header is stripped off before the packet is forwarded), or the Data Zone portion of the packet (both the EHS header and the CCSDS header are stripped off before the packet is forwarded).

5. Push the OK button on the Define Forwarding List dialog box.

6. Push the OK button on the Add A Packet dialog box to add the packet to the packet list.

7. Select the packet and then go the Packet menu and select Activate Packet to activate the packet.

Now everything is set up to forward packet 2. When you receive packet 2 it will be forwarded to the address(es) you added to the forwarding address list in the Add A Packet dialog box. If you need to change the forwarding list after the packet has been added to the packet list you can do this using the Packet Properties dialog box. Please reference the Telemetry Processing User Guide (TREK-USER-003) for details on how to use the Packet Properties dialog.

If you’re trying this out you need to perform the following additional steps to see forwarding in action. To make things simpler lets call the machine that is set up to forward the data Machine A. We’ll call the machine that is set up to receive the forwarded packets Machine B.

a. Set up Machine B to receive the packet that you are forwarding (packet 2).

b. Use the Telemetry Trainer on Machine A to send packet 2 to Machine A. Make sure you don’t send it to Machine B. Remember – you’re going to be forwarding it from Machine A to Machine B. Also, pay close attention to port numbers. Make sure you are sending and receiving with the correct port numbers.

c. Once you start sending data on Machine A you should see packet 2 on Machine B turn green. This means it is receiving the forwarded packets.

Kinda neat huh? : )
8. After you’re finished please exit the Telemetry Processing application.
Setting up your TReK System to Monitor Data
5.8 Setting up your TReK System to Monitor Data

Sometimes it’s important to monitor a particular telemetry value to ensure that it does not go out of limits or its expected state. This example will show you how to set up monitoring for a particular parameter.

Step-By-Step

1. First we need to do a little background set up. Start the Telemetry Processing application and add packet 7 to the packet list with the following properties:

   Database: <Full Path>\TelemetryDatabase.mdb
   Packet ID: 7
   Packet Type: PDSS Payload
   Data Mode: RealTime
   Processing Type: Process Entire Packet
   Local IP Address: <Your IP Address>
   Local Port Number: 6100
   Protocol: UDP
   Expected Packet Rate: 1 (Pkts/Sec)
   Packet Recording: Off
   Packet Forwarding: Off
   Packet Viewing: Off
   Packet Statistics Recording: Off

2. Go to the Packet menu and select Activate Packet. Once the packet is activated, go to the Parameter menu and select Monitoring. The dialog shown in Figure 13 will be displayed. Note that the only parameters shown in the list are those that have an associated monitor and are being processed (type of processing for the packet is “Entire Packet”).
3. Locate MSID009 in the list, select MSID009, and then select **Start Monitoring**. Note that the **Monitoring State** column changed from “OFF” to “ON” for MSID009. Close the Monitoring dialog. Your TReK System is now monitoring MSID009.

But where do I see the messages? – Good question that’s what we’re going to look at next.

Go to the **Parameter** menu and select **Monitoring Messages**. The dialog shown in Figure 14 will be displayed. This dialog shows all the monitoring messages generated when one or more parameters are being monitored. Messages in this dialog will never be deleted unless you push the Clear button. If the dialog is closed and you receive some messages, the messages will be stored and you will see them the next time you display the Monitoring Messages dialog. You can clear the messages by pushing the Clear button. However, once the messages are cleared, there is no way to get them back. Also, once you exit the application the messages will be lost. If you’d like to save the messages you can always copy them from the Monitoring Messages dialog and paste them into a Microsoft Word document.
4. Right now we don’t have any messages. That’s because we aren’t receiving any data, so there isn’t any data to monitor, and therefore no messages have been generated. Go to the Telemetry Trainer application and send packet 7. Wait a few seconds and you should start to see some messages. Figure 15 shows an example of a monitoring message.
Note: It is possible to resize the Show Monitoring Messages dialog. You can make it any size you want and place it anywhere on the desktop. Since it can be placed behind the Telemetry Processing main window its possible to lose sight of it. If this happens just look for it on the Windows Taskbar and click on the icon to bring it to the front.

5. After you’ve seen all the messages you want to see please exit the Telemetry Processing application.

So that’s it – now you know how to set up monitoring.
Changing a Polynomial Coefficient Calibrator
5.9 Changing a Polynomial Coefficient Calibrator

At some point you may want to change one of your processing elements. For instance you may want to change one of the coefficients for a polynomial coefficient calibrator or you may want to change the caution low value for a sensor. This example demonstrates how to make realtime updates to a processing element. A polynomial coefficient calibrator will be used in this example.

1. First we need to perform some background work. Start the Telemetry Processing application and add packet 7 with the following properties:

   Database:          <Full Path>\TelemetryDatabase.mdb
   Packet ID:         7
   Packet Type:       PDSS Payload
   Data Mode:         RealTime
   Processing Type:   Process Entire Packet
   Local IP Address:  <Your IP Address>
   Local Port Number: 6100
   Protocol:          UDP
   Expected Packet Rate: 1 (Pkts/Sec)
   Packet Recording:  Off
   Packet Forwarding: Off
   Packet Viewing:    Off
   Packet Statistics Recording: Off

2. Once packet 7 is in the list go to the Packet menu and select Activate Packet.

3. Once the packet is activated go to the Processing menu and select Calibrators. Locate the calibrator named MSID008 in the list and select it. Once MSID008 is selected push the Modify button. The dialog shown in Figure 16 will be displayed.
4. We are going to change the value of Coefficient 0 in Set Number 1 from 0 to 3. Push the Modify Set button. The dialog in Figure 17 will be displayed. Change the Coefficient 0 value to 3 and push OK.

![Figure 16 Calibrator MSID008 Properties](image)

![Figure 17 Modify Set Dialog for Calibrator MSID008](image)
5. Push the **OK** button in the Modify Polynomial Coefficient Calibrator dialog box.

6. Push the **Close** button in the Calibrators dialog box.

   **Note:** Remember, the change you have made is a realtime update and has not been stored in any database. If you want to save the change, you need to perform a **Save Configuration** so the information will be stored in a configuration file.

That’s it. Now you know how to update a processing element. From this point on any parameters that are using Calibrator MSID008 will be using the value 3 for Coefficient 0.

Please exit the Telemetry Processing application.
Adding a New Sensor
5.10 Adding a New Sensor

Often you can’t think of everything ahead of time. So there may be an occasion when you need a processing element that has not been defined in the database. This means you need to create one on the fly. It just so happens this is an easy thing to do. This example shows how to create a new processing element that you can use right away.

1. First we need to perform some background work. Start the Telemetry Processing application and add packet 7 with the following properties:

   - **Database:** <Full Path>\TelemetryDatabase.mdb
   - **Packet ID:** 7
   - **Packet Type:** PDSS Payload
   - **Data Mode:** RealTime
   - **Processing Type:** Process Entire Packet
   - **IP Address:** <Your IP Address>
   - **Port Number:** 6100
   - **Protocol:** UDP
   - **Expected Packet Rate:** 1 (Pkts/Sec)
   - **Packet Recording:** Off
   - **Packet Forwarding:** Off
   - **Packet Viewing:** Off
   - **Packet Statistics Recording:** Off

2. Once packet 7 is in the list go to the **Packet** menu and select **Activate Packet**.

3. Once the packet is activated go to the **Processing** menu and select **Sensors**.

4. Push the **New** button in the **Sensors** dialog. You will see a dialog similar to the one shown in Figure 18. The dialog shown in Figure 18 has already been filled in with the values you should enter. Select **Limit Sensor** in the **Sensor Types** list and then type in the name **Sensor1** for the sensor name.
5. Push the **OK** button in the **New Sensor** dialog. At this point you will be presented with the dialog shown in Figure 19.

6. Push the **Add Set** button in the **New Limit Sensor** dialog. The dialog shown in Figure 20 will be displayed.
7. In this step we’re going to fill in the Limit Information for Set Number 1 for Sensor1. However, before we fill in the correct values, we’re going to enter some invalid data to see what happens. Fill in the following Limit Information and push the OK button to see what happens.

<table>
<thead>
<tr>
<th>Caution Low:</th>
<th>-20</th>
<th>Warning Low:</th>
<th>-15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caution High:</td>
<td>5</td>
<td>Warning High:</td>
<td>10</td>
</tr>
<tr>
<td>Delta Limit:</td>
<td>2.5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

So what happened? -- When you pushed the OK button the dialog shown in Figure 21 should have been displayed. This dialog is titled Validation Messages and it displays a list of messages that explains what is wrong with data you entered.

Figure 20 Add Set dialog for Sensor1

Figure 21 Validation Messages for Sensor1
8. Now let's enter the correct data. Push the OK button on the Validation Messages dialog and enter the following "valid" data. When you are done push the OK button on the Add Set dialog.

Caution Low: -15  Warning Low: -20
Caution High:  5   Warning High: 10
Delta Limit:   2.5

Hint: If you happen to enter the wrong data (but it is still valid data so it is accepted) you can change the values again by selecting the Modify Set button. This will bring up the Modify Set dialog which you can use to modify the current values.

9. Let's make one more change to Sensor1. Let's add a description. Push the Modify Description button on the New Limit Sensor dialog. The dialog shown in Figure 22 will be displayed.

10. Type in the description Sensor1 is an alternate sensor used for MSID110. and push the OK button.

11. The New Limit Sensor dialog for Sensor1 should now look like the picture shown in Figure 23.
12. Now push the **OK** button in the **New Limit Sensor** dialog and look at the list of sensors in the **Sensors** dialog. You should now see Sensor1 in the list. That means that Sensor1 is available for use. (Note: Remember – if you save your configuration any processing elements that you have created will also be saved. However, if you do not save your configuration they will be lost. Its always a good idea to save your configuration when you create new processing elements.).

13. Close the Sensors dialog box by pushing the **Close** button.

14. Let’s save our configuration so we can use our sensor in the next example. Go to the **File** menu and select **Save**. When prompted for a filename enter the name `packet7_sensor1.tpc`.

15. Please exit the Telemetry Processing application.

**Note:** Remember, the change you have made is a realtime update and has not been stored in any database. That’s why we performed a Save Configuration.

That’s it. Now you know how to add a new processing element and save it.
Changing a Parameter’s Sensor
5.11 Changing a Parameter’s Sensor

In some situations you may want to use a different processing element for a parameter than the one that was originally assigned. For example, suppose that we want to use one sensor during one operational procedure and a different sensor during another operational procedure. This is easy to do. This example shows you how to change a parameter’s sensor.

The following example uses a sensor that was created in the example in section 5.10. If you have not worked through section 5.10 please go back and work that example before proceeding with this example.

1. The first thing we need to do is to open our previously saved configuration that we created in section 5.10. Start the Telemetry Processing application. Go to the File menu and select Open. When prompted enter the filename packet7_sensor1.tpc and push Open. Configuration packet7_sensor1.tpc should now be open. Select packet7 in the packet list and then go to the Packet menu and select Activate Packet.

2. Go to the Parameter menu and select Parameters.

3. In the Parameters dialog find parameter MSID110. Hint: You can sort the list by using the mouse to left click on any of the column headings. This will sort the list based on that column. Once you have found MSID110 select it and push the Modify… button. The dialog shown in Figure 24 will be displayed.
4. In the **Sensor** section of the dialog, go to the **Sensor Name** field and change the sensor name from MSID110 to **Sensor1**. Push the **OK** button.

5. Close the Parameters dialog.

Note: If you wanted to save the change what would you do? Right, you’d save the configuration. : )

That’s it. Now you know how to change a parameter’s sensor. If you needed to change a calibrator or a monitor, you would follow the same procedure.

Please exit the Telemetry Processing application.
Working with Ground Support Equipment (GSE) Packet Parameters
5.12 Working with Ground Support Equipment (GSE) Packet Parameters

For the most part, Ground Support Equipment (GSE) packets are handled exactly like PDSS packets. However, a GSE packet is a special type of packet that is generated and distributed by the Payload Operations Integration Center (POIC). A GSE packet may contain ground ancillary data or user defined data. A GSE packet is different from a PDSS payload packet in two respects: 1) the packet layout is a little different (which is not really that important), and 2) a PDSS payload packet only contains raw data whereas a GSE packet may contain raw data and/or preprocessed data. In other words, the POIC may perform some type of processing before the data is placed in the packet. The preprocessed data may be converted, calibrated, or limit/expected state sensed. Since the data may have been preprocessed, it’s possible that some type of error occurred during this preprocessing. The purpose of this section is to explain how you can set up your TReK system to control what TReK does when one of these errors occurs.

1. First we need to perform some background work. Start the Telemetry Processing application and add GSE Packet 776 with the following properties:

   - Database: \TelemetryDatabase.mdb
   - Packet ID: 776
   - Packet Type: GSE
   - Data Mode: RealTime
   - Processing Type: Process Entire Packet
   - Local IP Address: <Your IP Address>
   - Local Port Number: 6100
   - Protocol: UDP
   - Expected Packet Rate: 1 (Pkts/Sec)
   - Packet Recording: Off
   - Packet Forwarding: Off
   - Packet Viewing: Off
   - Packet Statistics Recording: Off

2. Once packet 776 is in the list go to the Packet menu and select Activate Packet.

Now that we have activated packet 776, let’s go look at one of the parameters in packet 776. Go to the Parameter menu and select Parameters. Once the Parameters dialog is available locate parameter ITWO_32 in the list. Notice that there are two parameters named ITWO_32 in the list. One arrives Converted and the other arrives Calibrated. Locate the ITWO_32 parameter that arrives Converted, select this parameter, and push the Modify button. The dialog shown in Figure 25 will be displayed on your screen.
3. Look at the bottom of the Modify Parameter dialog. You will see a section labeled Preprocessed Parameter. There are two pieces of information in this section. The Data Arrives field tells you how the data will arrive when it reaches your TReK system. This field will have one of the following values: Unprocessed, Converted, Calibrated. This field cannot be modified because it is defined when the packet is defined in the POIC Telemetry Database. The second field in this section is called Error Control Name. The Error Control Name is the name of an error control object that has been assigned to this parameter. The Error Control object is used to identify how TReK should handle specific POIC pre-processing errors. In general the error control object tells TReK whether it should try to process the parameter or return an error based on the type of pre-processing errors that have occurred at the POIC. Push Cancel to close the Modify Parameter dialog.
4. Let's take a look at the default Error Control object. A default Error Control object is available so you won't have to create one. Go to the Processing menu and select Error Control for Preprocessed Parameters. This dialog will show you a list of all the Error Control objects. Currently the default Error Control object is the only one available. Select the default item in the list and push the Modify button. The dialog shown in Figure 26 will be displayed on your screen.

![Modify Error Control for Preprocessed Parameter](image)

**Figure 26 Default Error Control Object**

5. The default Error Control object (like all Error Control objects) contains a list of all the preprocessing errors that can occur. This dialog provides a way for you to specify whether an error is allowed or disallowed. When you associate a particular error control object with a particular parameter you are specifying whether TReK should process the parameter or ignore it (based on whether a particular error is Allowed or Disallowed). If all errors are Disallowed, this means that if an error occurs, TReK will not process the parameter. If all errors are Allowed, then TReK will try to process the parameter despite any errors.

So that’s all there is to know about how TReK handles preprocessed parameters like GSE parameters. Other than that, GSE packets and parameters work exactly like PDSS Payload packets and parameters. If you’d like more information about the types of
preprocessing errors that can occur, please see the POIC to Generic User Interface Definition Document (SSP-50305).

Please exit the Telemetry Processing application.
Adding and Running a Display
5.13 Adding and Running a Display

Now that you know how to configure TReK to process data, let’s generate a display so we can see the data. In this section we’ll show you how to add a text display, customize how it looks, and run it.

1. First we need to perform some background work. Start the Telemetry Processing application and add packet 7 with the following properties:

   - **Database:** <Full Path>\TelemetryDatabase.mdb
   - **Packet ID:** 7
   - **Packet Type:** PDSS Payload
   - **Data Mode:** RealTime
   - **Processing Type:** Process Entire Packet
   - **Local IP Address:** <Your IP Address>
   - **Local Port Number:** 6100
   - **Protocol:** UDP
   - **Expected Packet Rate:** 1 (Pkts/Sec)
   - **Packet Recording:** Off
   - **Packet Forwarding:** Off
   - **Packet Viewing:** Off
   - **Packet Statistics Recording:** Off

2. Once packet 7 is in the list go to the Packet menu and select Activate Packet.

3. Once the packet is activated go to the Parameter menu and select Displays. The dialog shown in Figure 27 will be displayed.

![Image of Displays Dialog](image-url)

**Figure 27 Displays Dialog**
4. In the **Displays** dialog, push the **Add** button. The Add Display dialog is shown in Figure 28. This dialog provides a way for you to name the display, select which columns to show on the display, identify what parameters should be shown on the display, and set other display characteristics such as update rate, font, colors, grid lines, and text alignment.

![Add Display Dialog](image)

**Figure 28 Add Display Dialog**

5. In the Name field enter **Display1**.

6. Now we need to add some parameters to the parameter list. We will use the Add button to display a list of parameters. From this dialog we can select the parameters that should appear on the display. Push the **Add** button. The Add Parameter dialog shown in Figure 29 will be displayed.
7. This dialog is very similar to the Parameters dialog. You can select multiple parameters. Using the scrollbar, find and select parameters 108 through 115. Once you have selected these parameters, push the OK button.

8. Your Add Display dialog should now look like the dialog shown in Figure 30.
Here are a few items to note.

- When you add parameters, the alias for each parameter defaults to the parameter’s technical name. You can change the alias by selecting the parameter in the list and then pushing the Alias button. The Alias dialog will be displayed so you can change the alias.

- The Display field identifies what type of value will be displayed (Unprocessed, Converted, or Calibrated). If the parameter has an assigned calibrator, then the display type will default to “Calibrated”. If the parameter does not have a calibrator, but can be converted, then the display type will default to “Converted”. If the parameter cannot be converted (such as a parameter with data type IUND) then the display type will default to Unprocessed. If you would like to change the type of value to be displayed, just select the parameter and push the Unprocessed, Converted, or Calibrated button on the right hand side of the list. The rules noted above always apply. So if you try to display a calibrated value for a parameter that has no assigned calibrator you will get an error message.

- The Limit/ES setting is similar to the Display setting. If a sensor has been assigned, then the parameter will default to “Sense”. However, if no sensor is available, then the Limit/ES setting will default to “No Sense”.

- The Format field provides a way to set the number of places after the decimal point for values that will be displayed as real numbers. This applies to all parameters that have a floating point data type (such as FEEE) and will be displayed as a converted or calibrated value. It also applies to parameters that have either an integer or floating point data type (except IDIS) and will be displayed as a calibrated value. If a
parameter’s value will be displayed as a real number, then the Format field can be modified, otherwise it will be set to N/A and cannot be modified.

- The order of the parameters in the list, determines the order of the parameters on the display. You can select one or more parameters and then use the Move Up and Move Down buttons on the right hand side of the list to adjust the order of the parameters in the list.

- When you add parameters to the list, they are always added to the bottom of the list. Therefore, if you have arranged the list, and you add more parameters, the existing order will not be disturbed.

- You can use the column headings to sort based on a particular column. For example, if you want the parameters to appear in alphabetical order, the easiest way to accomplish this is to use the left mouse button to click on the Parameter column heading. You can sort in either ascending or descending order.

- The Columns checkboxes indicate which columns will be shown on the display. You must have at least one column selected. You can arrange the columns on the display once it is running. You can do this by holding down the left button on the mouse, over the column heading of the column you would like to move, and then moving the mouse in the direction you want the column to move. We will do this in a later step.

- The API Return column is used to display information related to the retrieval of the parameter’s value. If the API Return is “Success”, then the data was successfully retrieved. If the API Return is “Fail”, then an error occurred while trying to retrieve the data. If the API Return is “No Data Available”, it means TReK has not yet received this data. If the API Return is “Parameter Not Found”, this means that TReK is not currently configured to process this parameter.

Note: The API Return information is directly related to the TReK User Application Programming Interface library. The Telemetry Processing application uses this library to retrieve the data to be displayed. It is not necessary for you to be familiar with the User Application Programming Interface library to use the display capability. However, if you would like to learn more about the User Application Programming Interface library, please see the TReK User Application Programming Interface Library Reference Manual (MSFC-DOC-2800).

9. Now that we have the display defined all we need to do is push the OK button. Once we do this, the display will be added to the current configuration.
10. Using the Displays dialog you can Run, Modify, or Delete your display. Select Display1 in the list, and then push the Run button. Display1, shown in Figure 31, should appear on your desktop.

![Figure 31 Display1](image)

11. Since we aren’t receiving any data, Display1 shows No Data Available for all the parameters. To see the display update, we need to send some data. Since we don’t have any external data sources (such as the POIC or a Suitcase Simulator system), we’ll use the TReK Telemetry Trainer application to generate our packets. This is the same basic procedure we performed in earlier sections. To start sending data, perform the following steps:

   a. Use the Windows Start menu to start the Telemetry Trainer application.

   b. Use the Add A Packet dialog to add Packet ID 7 to the Telemetry Trainer packet list. All the fields in the Add A Packet dialog box will be filled with defaults except the Packet ID and the Database field. Enter 7 in the Packet ID field and the full path for the TelemetryDatabase.mdb database in the Database field.

      Note: Remember you want to send the same packet that you have set your TReK system up to receive. There should be a one-to-one correspondence between the information you entered in the Telemetry Processing application and the information you entered in the Telemetry Trainer application (Packet IDs, Packet Type, Data Mode, IP Address, and Port Numbers).

   c. After you add the packet to the list, start sending the data.
12. Display1 should now look similar to the display shown in Figure 32.

![Figure 32 Display1 with Data](image)

13. Now let’s move a column to a new location. Suppose you want to see the Value column on the far left. To move the Value column, just put your mouse cursor over the word Value. Then hold down the left mouse button and move the mouse to the left. You will see the Value column move to the left. When it’s in the right location release the mouse button. Your display should now look like the one shown in Figure 33.

![Figure 33 Display1 After Moving the Value Column](image)

14. In Figure 33 above (if you are looking at a color copy), notice that not all of the text in the Value column is white. The text associated with the value of MSID110 is red and the text associated with the value of MSID115 is yellow. These colors provide
sensing information. They correspond to the sensing status character that you see in the last position of the status string shown in the Status column. These colors will change as the sensing condition changes. You can change the assigned sensing colors using the Colors dialog. This dialog is available from the Add Display dialog or the Modify Display dialog. You can also change the display characteristics so that all the text in the row changes color or the entire row is highlighted using the assigned color.

15. You may be wondering if you can save the display. Displays are considered to be part of the current configuration. Therefore, if you save the configuration, then all your displays will be saved as part of that configuration.

16. Now lets close the display. To close the display, push the X in the top right hand corner of the Display1 window.

So that’s all you need to do to add and run a display. You can add any parameters that TReK is processing (Realtime or Playback), and you can customize your display in a lot of different ways. You can set the font, the colors, the way the text is aligned in each column, the display’s update rate, etc.

One other note: Remember that you can only display parameters that TReK is processing. If you delete a packet, then all the parameters associated with that packet are also deleted. If you have one or more of these parameters on a display, you will no longer be able to see the values for the parameters since the Telemetry Processing application no longer has that information.

Please exit the Telemetry Processing application.
Appendix A Glossary

Note: This Glossary is global to all TReK documentation. All entries listed may not be referenced within this document.

Application Programming Interface (API)
A set of functions used by an application program to provide access to a system’s capabilities.

Application Process Identifier (APID)
An 11-bit field in the CCSDS primary packet header that identifies the source-destination pair for ISS packets. The type bit in the primary header tells you whether the APID is a payload or system source-destination.

Calibration
The transformation of a parameter to a desired physical unit or text state code.

Communications Outage Recorder
System that captures and stores payload science, health and status, and ancillary data during TDRSS zone of exclusion.

Consultative Committee for Space Data Systems (CCSDS) format
Data formatted in accordance with recommendations or standards of the CCSDS.

Consultative Committee for Space Data Systems (CCSDS) packet
A source packet comprised of a 6-octet CCSDS defined primary header followed by an optional secondary header and source data, which together may not exceed 65535 octets.

Conversion
Transformation of downlinked spacecraft data types to ground system platform data types.

Custom Data Packet
A packet containing a subset of parameters that can be selected by the user at the time of request.

Cyclic Display Update Mode
A continuous update of parameters for a particular display.

Decommutation (Decom)
Extraction of a parameter from telemetry.

Discrete Values
Telemetry values that have states (e.g., on or off).
**Dump**

During periods when communications with the spacecraft are unavailable, data is recorded onboard and played back during the next period when communications resume. This data, as it is being recorded onboard, is encoded with an onboard embedded time and is referred to as dump data.

**Enhanced HOSC System (EHS)**

Upgraded support capabilities of the HOSC systems to provide multi-functional support for multiple projects. It incorporates all systems required to perform data acquisition and distribution, telemetry processing, command services, database services, mission support services, and system monitor and control services.

**Exception Monitoring**

A background process capable of continuously monitoring selected parameters for Limit or Expected State violations. Violation notification is provided through a text message.

**Expected State Sensing**

Process of detecting a text state code generator in an off-nominal state.

**EXPRESS**

An EXPRESS Rack is a standardized payload rack system that transports, stores and supports experiments aboard the International Space Station. EXPRESS stands for EXpedite the PRocessing of Experiments to the Space Station.

**File transfer protocol (ftp)**

Protocol to deliver file-structured information from one host to another.

**Flight ancillary data**

A set of selected core system data and payload health and status data collected by the USOS Payload MDM, used by experimenters to interpret payload experiment results.
Grayed out  Refers to a menu item that has been made insensitive, which is visually shown by making the menu text gray rather than black. Items that are grayed out are not currently available.

Greenwich Mean Time (GMT)  The solar time for the meridian passing through Greenwich, England. It is used as a basis for calculating time throughout most of the world.

Ground ancillary data  A set of selected core system data and payload health and status data collected by the POIC, which is used by experimenters to interpret payload experiment results. Ground Ancillary Data can also contain computed parameters (pseudos).

Ground receipt time  Time of packet origination. The time from the IRIG-B time signal received.

Ground Support Equipment (GSE)  GSE refers to equipment that is brought in by the user (i.e. equipment that is not provided by the POIC).

Ground Support Equipment Packet  A CCSDS Packet that contains data extracted from any of the data processed by the Supporting Facility and the format of the packet is defined in the Supporting Facility’s telemetry database.

Huntsville Operations Support Center (HOSC)  A facility located at the Marshall Space Flight Center (MSFC) that provides scientists and engineers the tools necessary for monitoring, commanding, and controlling various elements of space vehicle, payload, and science experiments. Support consists of real-time operations planning and analysis, inter- and intra-center ground operations coordination, facility and data system resource planning and scheduling, data systems monitor and control operations, and data flow coordination.
<p>| <strong>IMAQ ASCII</strong> | A packet type that was added to TReK to support a very specific application related to NASA’s Return to Flight activities. It is not applicable to ISS. It is used to interface with an infrared camera that communicates via ASCII data. |
| <strong>Limit Sensing</strong> | Process of detecting caution and warning conditions for a parameter with a numerical value. |
| <strong>Line Outage Recorder Playback</strong> | A capability provided by White Sands Complex (WSC) to play back tapes generated at WSC during ground system communication outages. |
| <strong>Measurement Stimulus Identifier (MSID)</strong> | Equivalent to a parameter. |
| <strong>Monitoring</strong> | A parameter value is checked for sensing violations. A message is generated if the value is out of limits or out of an expected state. |
| <strong>Parameter</strong> | TReK uses the generic term parameter to mean any piece of data within a packet. Sometimes called a measurement or MSID in POIC terminology. |
| <strong>Payload Data Library (PDL)</strong> | An application that provides the interface for the user to specify which capabilities and requirements are needed to command and control his payload. |
| <strong>Payload Data Services Systems (PDSS)</strong> | The data distribution system for ISS. Able to route data based upon user to any of a number of destinations. |
| <strong>Payload Health and Status Data</strong> | Information originating at a payload that reveals the payload’s operational condition, resource usage, and its safety/anomaly conditions that could result in damage to the payload, its environment or the crew. |
| <strong>Payload Operations Integration Center (POIC)</strong> | Manages the execution of on-orbit ISS payloads and payload support systems in coordination/unison with distributed International Partner Payload Control Centers, Telescience Support Centers (TSC’s) and payload-unique remote facilities. |</p>
<table>
<thead>
<tr>
<th><strong>Payload Rack Checkout Unit (PRCU)</strong></th>
<th>The Payload Rack Checkout Unit is used to verify payload to International Space Station interfaces for U.S. Payloads.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Playback</strong></td>
<td>Data retrieved from some recording medium and transmitted to one or more users.</td>
</tr>
<tr>
<td><strong>Pseudo Telemetry (pseudo data)</strong></td>
<td>Values that are created from calculations instead of directly transported telemetry data. This pseudo data can be created from computations or scripts and can be displayed on the local PC.</td>
</tr>
<tr>
<td><strong>Remotely Generated Command</strong></td>
<td>A command sent by a remote user whose content is in a raw bit pattern format. The commands differ from predefined or modifiable commands in that the content is not stored in the POIC Project Command Database (PCDB).</td>
</tr>
<tr>
<td><strong>Science data</strong></td>
<td>Sensor or computational data generated by payloads for the purpose of conducting scientific experiments.</td>
</tr>
<tr>
<td><strong>Subset</strong></td>
<td>A collection of parameters from the total parameter set that is bounded as an integer number of octets but does not constitute the packet itself. A mini-packet.</td>
</tr>
<tr>
<td><strong>Super sampled</strong></td>
<td>A parameter is super sampled if it occurs more than once in a packet.</td>
</tr>
<tr>
<td><strong>Swap Type</strong></td>
<td>A flag in the Parameter Table of the TReK database that indicates if the specified datatype is byte swapped (B), word swapped (W), byte and word swapped (X), byte reversal (R), word reversal (V) or has no swapping (N).</td>
</tr>
<tr>
<td><strong>Switching</strong></td>
<td>A parameter’s value can be used to switch between different calibration and sensing sets. There are two types of switching on TReK: range and state code.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transmission Control Protocol (TCP)</td>
<td>TCP is a connection-oriented protocol that guarantees delivery of data.</td>
</tr>
<tr>
<td>Transmission Control Protocol (TCP) Client</td>
<td>A TCP Client initiates the TCP connection to connect to the other party.</td>
</tr>
<tr>
<td>Transmission Control Protocol (TCP) Server</td>
<td>A TCP Server waits for (and accepts connections from) the other party.</td>
</tr>
<tr>
<td>Telemetry</td>
<td>Transmission of data collected from a source in space to a ground support facility. Telemetry is downlink only.</td>
</tr>
<tr>
<td>Telescience Support Center (TSC)</td>
<td>A TSC is a NASA funded facility that provides the capability to plan and operate on-orbit facility class payloads and experiments, other payloads and experiments, and instruments.</td>
</tr>
<tr>
<td>User Application</td>
<td>Any end-user developed software program that uses the TReK Application Programming Interface software. Used synonymously with User Product.</td>
</tr>
<tr>
<td>User Data Summary Message (UDSM)</td>
<td>Packet type sent by PDSS that contains information on the number of packets sent during a given time frame for a PDSS Payload packet. For details on UDSM packets, see the POIC to Generic User IDD (SSP-50305).</td>
</tr>
<tr>
<td>Uplink format</td>
<td>The bit pattern of the command or file uplinked.</td>
</tr>
<tr>
<td>User Datagram Protocol (UDP)</td>
<td>UDP is a connection-less oriented protocol that does not guarantee delivery of data. In the TCP/IP protocol suite, the UDP provides the primary mechanism that application programs use to send datagrams to other application programs. In addition to the data sent, each UDP message contains both a destination port number and a fully qualified source and destination addresses making it possible for the UDP software on the destination to deliver the message to the correct recipient process and for the recipient process to send a reply.</td>
</tr>
<tr>
<td>User Product</td>
<td>Any end-user developed software program that uses the TReK Application Programming Interface software. Used synonymously with User Application.</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Web</td>
<td>Term used to indicate access via HTTP protocol; also referred to as the World Wide Web (WWW).</td>
</tr>
</tbody>
</table>
Appendix B Acronyms

Note: This acronym list is global to all TReK documentation. Some acronyms listed may not be referenced within this document.

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOS</td>
<td>Acquisition of Signal</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>APID</td>
<td>Application Process Identifier</td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange</td>
</tr>
<tr>
<td>CAR</td>
<td>Command Acceptance Response</td>
</tr>
<tr>
<td>CAR1</td>
<td>First Command Acceptance Response</td>
</tr>
<tr>
<td>CAR2</td>
<td>Second Command Acceptance Response</td>
</tr>
<tr>
<td>CCSDS</td>
<td>Consultative Committee for Space Data Systems</td>
</tr>
<tr>
<td>CDB</td>
<td>Command Database</td>
</tr>
<tr>
<td>CDP</td>
<td>Custom Data Packet</td>
</tr>
<tr>
<td>COR</td>
<td>Communication Outage Recorder</td>
</tr>
<tr>
<td>COTS</td>
<td>Commercial-off-the-shelf</td>
</tr>
<tr>
<td>CRR</td>
<td>Command Reaction Response</td>
</tr>
<tr>
<td>DSM</td>
<td>Data Storage Manager</td>
</tr>
<tr>
<td>EHS</td>
<td>Enhanced Huntsville Operations Support Center (HOSC)</td>
</tr>
<tr>
<td>ERIS</td>
<td>EHS Remote Interface System</td>
</tr>
<tr>
<td>ERR</td>
<td>EHS Receipt Response</td>
</tr>
<tr>
<td>EXPRESS</td>
<td>Expediting the Process of Experiments to the Space Station</td>
</tr>
<tr>
<td>ES</td>
<td>Expected State</td>
</tr>
<tr>
<td>FAQ</td>
<td>Frequently Asked Question</td>
</tr>
<tr>
<td>FDP</td>
<td>Functionally Distributed Processor</td>
</tr>
<tr>
<td>FSV</td>
<td>Flight System Verifier</td>
</tr>
<tr>
<td>FSV1</td>
<td>First Flight System Verifier</td>
</tr>
<tr>
<td>FSV2</td>
<td>Second Flight System Verifier</td>
</tr>
<tr>
<td>FPD</td>
<td>Flight Projects Directorate</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>GMT</td>
<td>Greenwich Mean Time</td>
</tr>
<tr>
<td>GRT</td>
<td>Ground Receipt Time</td>
</tr>
<tr>
<td>GSE</td>
<td>Ground Support Equipment</td>
</tr>
<tr>
<td>HOSC</td>
<td>Huntsville Operations Support Center</td>
</tr>
<tr>
<td>ICD</td>
<td>Interface Control Document</td>
</tr>
<tr>
<td>IMAQ ASCII</td>
<td>Image Acquisition ASCII</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>ISS</td>
<td>International Space Station</td>
</tr>
<tr>
<td>LDP</td>
<td>Logical Data Path</td>
</tr>
<tr>
<td>LES</td>
<td>Limit/Expected State</td>
</tr>
<tr>
<td>LOR</td>
<td>Line Outage Recorder</td>
</tr>
<tr>
<td>LOS</td>
<td>Loss of Signal</td>
</tr>
<tr>
<td>MCC-H</td>
<td>Mission Control Center – Houston</td>
</tr>
<tr>
<td>MOP</td>
<td>Mission, Operational Support Mode, and Project</td>
</tr>
<tr>
<td>MSFC</td>
<td>Marshall Space Flight Center</td>
</tr>
</tbody>
</table>
TREK-USER-017

MSID  Measurement Stimulus Identifier
NASA  National Aeronautics and Space Administration
OCDB  Operational Command Database
OS    Operating System
PC    Personal Computer, also Polynomial Coefficient
PCDB  POIC Project Command Database
PDL   Payload Data Library
PDSS  Payload Data Services System
PGUIDD  POIC to Generic User Interface Definition Document
POIC  Payload Operations Integration Center
PP    Point Pair
PRCU  Payload Rack Checkout Unit
PSIV  Payload Software Integration and Verification
RPSM  Retrieval Processing Summary Message
SC    State Code
SCS   Suitcase Simulator
SSP   Space Station Program
SSCC  Space Station Control Center
SSPF  Space Station Processing Facility
TCP   Transmission Control Protocol
TReK  Telescience Resource Kit
TRR   TReK Receipt Response
TSC   Telescience Support Center
UDP   User Datagram Protocol
UDSM  User Data Summary Message
URL   Uniform Resource Locator
USOS  United States On-Orbit Segment
VCDU  Virtual Channel Data Unit
VCR   Video Cassette Recorder
VPN   Virtual Private Network